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1 Introduction 

1.1 Project background 
 

The SP3 panel of the NSRP instigated a white paper project to evaluate the 
use of Statistical process control techniques as a method to improve the 

quality and productivity of coating activities. 
 

The project outlined comprised two phases: 
 

Phase I – was a review of the potential for using SPC tools and techniques 
and was reported in Safinah report no… and presented to the SP3 panel at 

Louisville in June 2005. The outcome of this was the development and 
specification of a manual system that any computer system would have to be 

able to deal with. 
Phase II – was to focus on a search for any software that may enable yards to 
more easily adopt the tools and techniques identified in Phase I and in failing 
to do that, develop some specifications for software to be developed at some 

later stage to meet the project needs. 
  

1.2 Phase II work 
The phase II work comprised the following key steps: 

 
Assess feedback to phase I work after final report and presentation. 

Review software available “off the shelf” 
Identify a suitable piece of software and run a case study with the partner 

shipyard – Atlantic Marine. 
Report on the case study and obtain feedback from the shipyard as to ease of 

use based on feedback from the case study. 
 

2 Feedback from phase I 

2.1 Feedback review 
 

The feedback from phase I that was provided to the project team was that the 
phase I report had provided a very good base from which the project could 
progress. The development of the manual system was accepted as a good 

base solution and the material provided in the first phase report also provided 
a good reminder of how all these tools and techniques fitted into the ongoing 

lean initiatives at the various yards.  
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3 Phase II work 

3.1 Computer software review 
 

From the base of the manual system developed in Phase I Safinah 
investigated a variety and range of SPC software that was commercially 

available to see if a system could be identified that followed the basis of the 
manual system outlined in Phase I. 

 
The review took in some 20 software programs, all of whose manufacturers 

were approached and either web based demonstrations carried out or 
detailed specifications of the software capability was reviewed. 

 
The products fell into a number of categories. 

 
Industry specific products 

These included products tailor made for the automotive industry in particular 
and therefore focus on mass production systems. 

Statistical analysis tools 
Software that offered a considerable array of statistical analytical techniques 

that allowed data collected to be analysed in variety of ways. 
Control chart generation software 

Focus primarily on control charting tools and techniques. 
 

The feedback from the questionnaire work carried out in Phase I identified a 
broad range of analysis and tools required of which simple charting 

techniques were only a small part. 
 

The yards also identified that initiatives such as Lean production had already 
introduced tools and techniques such as 5 Whys and 5 S that they wish to 

incorporate into any problem solving approach. 
 

In addition the yards also have some of their own forms and reports already in 
place for many problem solving activities so it would be useful to be able to 
easily refer to these or to take data from them to manage a problem solving 

project rather than re-inventing them or developing alternative.   
 

Thus the software should provide a structure to enable a variety of problems 
to be managed as they are solved in a true quality improvement approach. 

 
It should be able to easily refer and draw on existing data 

 
It should allow an adequate level of analysis to be carried out. 

 
It should manage the work, communication and results for any problem 

solving activity. 
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4 Solution identified 

4.1 Software solution 
The research into the various software available generated one very 

promising option this is: 
 

Pathmaker software developed by Skymark in Pittsburgh PA. 
 

A demonstration versions was downloaded by the project members and 
trialled for 30 days at the end of which it was agreed that the project should 
invest in a copy of the software as it appeared to meet the requirements set 

out in Phase I. 
 

The software was purchased and has now been installed at the Atlantic 
Marine shipyard and a problem pathway set up for the first problem to be 

assessed that of Overspray management. 
 

The path developed for this is shown in figure 4.1 
 

 
 

A file was created in windows called overspray to hold all the elements of the 
project. 

 
The basic project information was input into the project information sheet 

(figure 4.2) 
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Details of team members were then completed, this function provides an e-
mail link as well as access rights for users. Figure 4.3 

 

 
 

The project was started with a powerpoint presentation prepared in MS Office 
and hyperlinked into the project through the hyperlink tool on the Pathmaker 
system (this is a simple click of a button and a location of the desired file). 
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The cost of quality was then assessed using a cost of quality template 

provided within the Pathmaker programme, alternatively this could have been 
undertaken on an excel spreadsheet and also heyperlinked. 

 
The cause and effect tool was then used for the team members to analyse the 
potential causes of the problem. This was also linked to the yards own 5 Why 
forms so that all documentation for the project could be tied into one folder. 

 
Each step was undertaken either using the tools built into the Pathmaker 
software or linked to existing MS Office documents, pictures or scanned 

forms. 
 

The project took about 20 minutes to set up and if the software is run over the 
intranet the individual team members can contribute to a project remotely 

prompted by e-mails by the project leader and actions can be undertaken a 
discussion group set up etc. 

 
Appendix 1 includes the overview of the software. 

 

5 Conclusions on the software 

5.1 Features 
 

The software met all of the requirements set out in Phase I of the report, 
either through its own inbuilt tools or its ability simply refer to other software or 
documents and link those into the project so that all documentation relating to 

a particular problem solving initiative could be easily logged, filed and 
accessed. 

5.2 Costs 
 

The cost of the software can be found on the web site www.skymark.com as 
can a download to trial the software for free for 30 days. 

 
The costs are as follows: 

 
 

No 
Licences 

1-4 5 pack 10 
pack 

25 
pack 

100 
pack 

500 
pack 

1000+ 

Price $295 
each 

$275 
each 

$250 
each 

$225 
each 

$200 
each 

$180 
each 

$170 
each 

 
For 12 months after purchase all upgrades are free. 
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6 Case study work 
 

6.1 Initial desk top trials 
 

On receipt of the software, Corrosion Correctors, Atlantic Marine and Safinah 
ltd all tested the software on a 30 day free trial.  

 
On conclusion of the trial it was decided collectively that the software would 

perform the tasks set out in phase I. 
 

Safinah then went on to purchase a copy of the software (now residing with 
Atlantic Marine) and continued testing and evaluation. 

 

6.2 Yard testing 
 

Safinah then took the software on site to Atlantic Marine in Jacksonville and 
together with the paint department developed the case study outlined above. 

 
The results presented are by necessity an overview as much of the data input 
into the case study was considered commercially sensitive by Atlantic Marine. 

 
The software was found easy to install (5 minutes) and the case study on 

overspray was set up over the course of one afternoon. 
 

The software proved to be intuitive and linked nicely with the élan production 
activities in the yard. 

 
In fact on the second day the lean production team visited the paint 

department to review the software and get a presentation of its capabilities 
and the overspray case study and the outcome was that the steel department 

also applied for the 30 day free trial. 
 
 

7 Project conclusions 
 

The partners deemed the project a success. The software identified carried 
out all the requirements set out by phase I. it is easy to use and has the 

added benefit of working through hyperlinks with MS office, thus allowing the 
power of each of those programmes to be used also. 

 
It has also been linked to Adobe acrobat and other software. The yard is 

investigating a link to Microsoft project manager. 
 

Tasks can be copied from one project to another. 
 

Weaknesses evident at present: 
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Within the scope of the work carried out in the pilot project, no specific 

weaknesses could be determined at present. The key unknown area is how 
the system would really perform live across a shipyard intranet. This could not 

be readily evaluated within this project, although sending e-mails and 
meetings functions were tested successfully. 
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8 Appendix 1 – user guide 

Appendix 1 PathMaker 5.5.pdf



 

 

 

 
PathMaker® 5.5 

             Getting Started 

 

 

 
Main Telephone: (800)826-7284 or +1.412.371.0680 
Facsimile: (412)371-0681 
Tech Support: (412)371-4791 

 

SkyMark 
7300 Penn Avenue, 
Pittsburgh, PA 15208 USA 

Web: www.skymark.com 
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Starting a New Project 

In PathMaker, one file contains all the work required to complete a given mission. This file is called a project. When you run 
PathMaker, the Start Project dialog box will appear. 

If you want to use a pathway template, select the "Choose a pre-built 
template" option and click on the OK button. Then, in the Select a 
Template  dialog box that opens, select the template you want to use for 
your project and click on the OK button. See Choosing a Project 
Pathway Template  for more information. The Choose a Project Name 
and Location dialog box will appear. In the dialog box, type in a name 
for your new project and click on the Save  button.   You will then be 
asked to log in to the project.  See About the Log in Screen for more 
information. 

If you want to create your own pathway from scratch, select the "Using a 
blank Pathway" option and choose the OK button. In the Choose a 
Project Name and Location dialog box, type in a name for your new 
project and click on Save  button.  
 
 

 
Main Frame Toolbar 

You will also notice the mainframe toolbar in the top left corner displayed under the menu bar of the application window, when 
no project files are open.   

Click: To: 

 
Create a new project in PathMaker. Shortcut: CTRL+N 

 
Open an existing project. Shortcut: CTRL+O 

 
Activate the Context Help pointer to get help on menus, buttons, and other screen items. 

 
Activate the Help Cards. 

 
About the Log In Screen 

When you create a new project, you are the Administrator.  You create your User ID and a password.  A password is not 
required.  Both are case sensitive. Once in the project, you will be able to create ID’s and passwords for any additional team 
members.  Note: If you lose your User ID or Password, you will have to email your file to support@skymark.com  for 
technical assistance in retrieving it. 

 
User ID Type in your ID in the project. 

Password Type in your password for the project. 

Confirm Password Confirm the password you have selected for this project. 

Remember Name 
and Password 

Select this box to have PathMaker remember these items for you 
each time you enter this project. 

OK button Confirm the name and password to login the project. 

 

 

Help button Open the help topic related to the dialog box.  
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Record the Information About a Project 

Look at your screen. You should see a blank project pathway window with five tabs at the top: 

 
The Project Pathway Tab - opens the Pathway or the map of a project. 

 
The Project Information Tab- opens the Project Information form where you can name your project, and 
enter some information about it. 

 
The Team Members Tab-opens the Team Members list. Team Members are users who can access the 
project at the same time. If you are the administrator, you can add team members and edit the information of 
them. If you are one of other users, you can only view the information and edit your own profile. 

 
The Action Items Tab- opens the Action Items list that lets you record tasks related to your project. The 
action items recorded in meeting agendas are also stored here. 

 
The Discussion History Tab- opens the Discussion History list that lets you record all the discussion 
related to the project. You can add or join a discussion from this view.  

Add Tools to Build A Pathway 

Now, let’s add some steps to the pathway, i.e. the tools we’ll use to plan and execute our project. 

On the tool bar, click the Add Slide Show button. 

 

In the dialog box that opens, select the “Strategic Planning” directory, and the first slide in the list of slide files. Press OK.  

The slide show gets added to your pathway. 

Next, click the tool bar buttons to add a Brainstorm, a Cause and Effect Diagram, and a Flowchart tool to your pathway.  

     
You will see the pathway grow as you add steps to it. 
 

Launch and Close Tools 

We’ve added steps. Now, we’re going to launch and use them. Double-click on the launch icon of the slideshow tool that you 
added. 

 

The slideshow tool window will open, and you will see the first slide in the strategic planning slide show. PathMaker 5.5 has 32 
built-in slide shows, including one for each kind of tool, and some more general ones. You can use them for quick introductory 
training or refreshers. 

You can use the navigation links in the slides to page through the slide show, and read a brief summary of strategic planning 
methods.  

When you’re done, click on the Close Window button to return to the Project Pathway window.   

Next, launch the brainstorm tool, which is the next step on your pathway. The launch button is to the left of the text that says 
“Brainstorm Tool”.  
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A dialog box will appear asking you to enter the "central question" of the brainstorm: 

 
Once in the Brainstorm, you’ll see a split window. You will see your "central question" in the upper left corner.  This is also 
where Brainstorming ideas will go after they are typed into the Enter Idea space.  The right side is for an affinity diagram. We’re 
not going to do a brainstorm now; this is just to illustrate how to launch and close tools. You’ll notice that the menus and the 
toolbar, or row of buttons under the menu bar, change according to the tool window you are using. 

Close the Brainstorm tool window, using the Close Window button. 

Dividing Your Pathway into Stages 

You can add stages to your pathway, which simply act as headings for a series of steps, rather like chapter titles in a book. To add 
a stage, click on the Add Stage button on the toolbar of the pathway window.   

  The text “Stage Line" will be added to your pathway. You can edit it to describe the steps to follow.  

Adding Hyperlinks 

There are many tools contained in PathMaker 5.5, but it is often helpful to be able to link the tool to some other file, e.g. a 
spreadsheet or document that relates to the project, or to a web page. You can use the Add Hyperlink button to add one of these 
links to your pathway. 

 

Editing Step Descriptions 

Each step has a textual description beside its launch button. There’s a default description for each tool, but it is fully editable, and 
you will usually want to change it so that it is more descriptive of the particular contents of the tool. 

Marking Steps as Complete 

To the left of the launch button for each step is a checkbox, which you can use to mark a step as being complete. Checking a box 
doesn’t lock a tool; it is just a visual indicator that a step is finished. 

Using PathMaker's Tools 

Each of PathMaker’s tools has its own menus, its own toolbar, and its own set of functions. We’ll take a brief look at each tool.  

PathMaker 5.5 provides you with multi-user functions. All team members specified in the Team Members list can access the 
project and even the same tool at the same time. However, in a tool, only the team member who has control can edit the tool.  
Others may watch the changes. 

Press down the Ask for Control  button each time when you want to edit a tool. Release the button to give up control when you 
finish. 

 

Saving Projects 

You don't need to save the project or the tools.  Because PathMaker projects are stored in a database, updates to records are made 
automatically. 
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Brainstorming and Affinity Diagramming 

 

Launch the brainstorm tool again. Press down the Open Floor button  so that all team members can submit their ideas. Enter 
your ideas in the Enter Idea box, they will then appear on the left hand side. Don’t worry about whether your ideas are sensible; 
it’s a brainstorm!  

When you run out of ideas, release the Open Floor button so 
that you can start grouping ideas into an affinity diagram – a 
sorted brainstorm. Select one problem, for example, "good 
feedback", and drag it to the empty line in the affinity set on 
the right side of the screen. Does the next idea belong with it? 
If so, drag it to the same set. Otherwise, drag it to the second 
affinity set, and continue in this way. Just select the Close 
Window button when you are finished. 

 
 

 

 

 

 

Cause and Effect Analysis 

 

Launch the C&E Diagram tool from the Pathway. You get a right-angled version of the classic Ishikawa fault tree. Decide on a 
problem that you want to focus on, and enter it in the Main Effect node (the first box you see).  

Then, try to determine factors contributing to this effect.  

By clicking on the plus buttons  in the chart, you can add nodes that eventually build a tree of causes for this main effect. 

You can also save your diagram as a bitmap  for use in other word processing applications. 

 

While you’re thinking, you can experiment with the software. Try to 
collapse and restore branches, adjust spacing, change node sizes, edit 
colors or anything else. Click on a node to select it, and notice how you 
can drag and drop it on another to attach the two nodes. 

This tool doubles as a tree diagram, which you can use to plan the 
various strands of a project. 

When you have finished with your cause and effect diagram for the 
moment, use the Close Window button to return to your project 
pathway. 
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Flowcharting 

 

Now launch the flowchart tool by clicking on the flowchart step’s launch button. 

You’ll see the flowchart window open. In this window, you have all the appropriate buttons and menus for the quick construction 
of flowcharts. You can add shapes and then connect them, change their colors, align them, align the text within them, etc. 

 

For a quick review of flowcharting and the meaning of the different 
shapes, you might want to read through the flowchart slide show. 
Each tool’s slideshow is just a click away. Use the View Slideshow 
button to launch it.  

 
On the flowchart toolbar, click the add shape button.  

 

Then click down in the blank workspace in the window. When you 
click, PathMaker 5.5 creates a shape of the type you have selected. 
Immediately after you create a shape, it is ready for text entry. If you 
start typing the text will appear inside the shape. 

With your mouse, click on the add shape button again, and add it to 
your chart. Type in some text. Then, on the toolbar, this time click on 
the add connection button.   

 

If you click inside one shape, and drag the cursor over into the other shape, and then release the mouse button, PathMaker 5.5 
draws a connection between the two shapes.  

If you are going to add several shapes or connections in a row, it is quicker to use the Mode Lock button . If the little 
padlock icon shows as being locked, you will stay in your current mode – e.g. connection mode, until you choose another mode. 
In Lock Mode, you can keep connecting shapes without having to keep selecting the add connection button. 

 

You can also save your flowchart as a bitmap for use in other word processing applications . 

You can play with some of the other flowcharting functions as you construct a flowchart that depicts one of the processes that 
leads to a world problem you want to fix. Most are available on the button bar or under the Flowchart menu command. They are 
largely self-explanatory, and there is help on each one. 

 

Detour - A Quick Look at PathMaker 's Help System 

PathMaker 5.5 has extensive help resources. You’ve already seen the slide shows that are built-in. There is always a relevant 
slide show link on your toolbar, which is activated by the View Slide Show button. 

 

You may also use the help button.  
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If you click on this button, and then point your cursor to something else in your window, and click on it, PathMaker 5.5 will 
display the help topic related to the item you pointed to. 

For quick and brief help, you can use the help cards . 

Help cards are little decks of cue cards, which give you quick overviews of how to work in the various tools. The cards you see 
are always related to the tool window that is being displayed. 

Finally, there is the standard on-line Help system, with a searchable index, table of contents, a glossary, and other reference 
material. To open Help, choose the PathMaker Help command from the Help menu or press F1 on the keyboard. 

Other management resources, links, notes, explanations of tools and answers to frequently asked questions are available at our 
excellent web site, www.skymark.com. 

Force Field Analysis 

In the pathway window, add a Force Field Analysis step to your pathway.   

 

Use the launch button to launch the Force Field Diagram window.  

 

The Force Field Diagram is very simple – just two lists. You usually use it to list the driving forces behind an idea, vs. the forces 
that will tend to restrain an idea.  

 

 For example, imagine you want to determine what forces affect UN 
involvement in improving world processes. You can type some ideas into 
the driving force section of the force field diagram: the need for 
international law framework, civil wars could make it desirable for 
humanitarian reasons, etc... Restraining forces could be that nations do 
not want to surrender sovereignty, nations may not agree on prescriptive 
measures, etc… 

Then you can use the arrows to graphically depict the strength of the 
various forces.  

 

If you are going to try to effect a change, you need to strengthen the 
driving forces, and try to weaken the restraining forces.  

After you finish, close the window. 

 

 

Consensus Builder 

If you are trying to narrow down a list of possible actions or candidates, and to build consensus for a given choice, the consensus 
builder tool can be a great help. There are two basic voting/rating methods available to you in the consensus builder tool: multi 
voting and multi-criteria rating.  

Before you begin, just a quick note on terminology…Consensus Builder uses election terminology throughout. Different 
alternatives or ideas that you are considering are referred to as candidates. Each person involved in the process is a voter, and 
each voter will cast a ballot. The whole process is an election. 
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Add a consensus builder tool to your pathway, and launch it.  

 

When you open the tool for the first time, the tool is in Setup Mode.  

 

In Setup Mode, first define the issue you are voting on. Then specify 
whether you want to multi vote (recommended if you have more than 
8-10 candidates), group multi vote (good for long lists or large teams) 
or rate the different alternatives (best for short lists of candidates 
where you want to examine each one in detail). 

Choose the voters and a rating scale (if you are rating), enter the 
names of the candidates, enter criteria (again, if you are rating 
candidates against several criteria), and whether you want to weight 
the relative importance of the criteria. 

Use this email button to notify team members who are not online that 
they need to vote. 

 

Once you have finished setting up your election, press the Vote! 
button: 

 
 

In a multi-criteria rating vote, each voter has the opportunity to 
weight each criterion. There may be times when you do not want to use the weights and would prefer all the criteria to be treated 
equally in figuring the results. Thus PathMaker lets you choose between having the weights enabled or disabled.  

 

PathMaker 5.5 will set up a ballot for each voter. Each voter clicks on the round circles to fill them in, just as one would fill in a 
standardized test form.  

 

When the ballot is complete, press the Cast Ballot button . 

 

Once all the ballots have been completed and cast, the final voting result will be displayed. 

You can use the Sort Results button to sort the voting results into descending order . 

 

Divisive issues will be highlighted in red. The Consensus Threshold button  lets you set the level at which you want to flag 
areas of disagreement within the group. This is a very powerful way of focusing on the specific causes of disagreement, and 
getting issues onto the table before going further. 

 

The display chart command  brings up the Consensus Analysis dialog box, which contains a chart of the rating results for 
the cell.  This command is only available when the selected cell contains data which may be graphed. 
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The Recorder of the vote may use this command  to view results while the vote is in progress. 

Forms 

There are some forms that are useful in process improvement and strategic planning.  

PathMaker 5.5 includes a forms design tool, and a set of pre-designed form templates.  

 

Add a form to your pathway by clicking on the add form button .  When you first launch this tool you will see. Select a 
Template dialog box appear. If you wish to use an existing form, select it from this list.  If you wish to create your own select the 
Blank Form.  Once in the form you have chosen if you wish to change it go to File and Change Template . The list of pre-
designed form templates will appear to choose from. 

 

If you want to change the design of the form, press down the Design 
Mode button to turn on your design options.   

 

If you do make design changes, you can save them as templates for 
future uses using the Save As Template  command on the File menu. 

If you just want to fill in the form, stay in use mode by releasing the 
Design Mode  button. 

 

 

Data Analyst 

The Data Analyst tool gives you a quick and easy way to generate all the chart types used in process improvement and strategic 
planning work.  

 
Add a Data Analyst tool to your pathway, and launch it.  

 

Pick a chart type that you want to create, and work your way through the wizard. When you first finish with the wizard, you get a 
split screen, with an empty chart window above, and an empty data grid below. Below the column headers of the grid (labeled A, 
B, C etc.) there is a row of gray cells. This row contains assignable headers. You use these headers to tell PathMaker 5.5 where 
the data is that you want to use for constructing a chart. Each chart type has specific headers. Those headers appear in a drop-
down list if you click on one of the assignable headers cells. 
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It brings up the chart choice wizard again, and lets you choose another chart. If you pick a different chart type, the preassigned 
headers will usually be different, since the headers are always appropriate to the chart that is being displayed. 

 

 

To configure the options for a chart, select the Chart Options button  on the 
toolbar.  

This will open a dialog with several tabs, where you can select options for chart display, 
titles, the scales of x and y-axes, and more.  

 

 

 

 

 

 

 

The More options tab will launch the Chart FX® Properties Dialog box.  Within this 
box you are able to customize your charts even further in relation to 3D, cluster or 
stacked.  Also the appearance of grid lines, axis style, color palette, background or 
scheme, customization of point markers, and tickmarks among other features. 

To display the statistics associated with a chart, press the Display Statistics  button. 

 

 

 

 

 

Enter some data into the columns under your preassigned headers. 
Under the assignable header row, there is a third row of cells.  If you 
enter text here, it will be interpreted as series labels.  Enter your data in 
the appropriate columns and a chart will appear.  You can construct any 
number of charts from one grid of data.   

To add a second chart, click on the Add Chart button.  
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To import data from another source, you can copy and paste, or use the Get External Data command on the Data Analyst 
menu.  

Once you have imported data from an external data source, you can set up a permanent link to it. That way, any changes being 
made in your database will be reflected in your data analyst chart. From Get External Data go to Setup Live Link. This 
command will launch the Live Link Setup Dialogue Box: 
 

 

There are many other functions and options in the Data Analyst tool. A detailed explanation 
is beyond the scope of this quick start guide, but there are such explanations in the help 
system and the User’s Guide. You will quickly learn how most of the options work by 
exploring the menus – particularly the Edit and Data Analyst menus – and the toolbar. The 

Help Pointer  can also be very useful for such exploration. 

 

 

 

Running Meetings with PathMaker  

You can add meetings to your project pathway, and include steps from the pathway in a Meeting Agenda that PathMaker 

generates. To add a meeting, select the Add Meeting button  on the toolbar of the pathway window. 

 

Look for the bracket to the left of the meeting step. Click on the bottom of the bracket, and drag it down until it includes the steps 
that you want to take in your first meeting.  These will appear under the Agenda Items section.   

 

 

Launch the Meeting Agenda by double-clicking on its launch icon on the pathway. Enter the appropriate information (e.g. time 
and place). For a real meeting, you could print out the meeting agenda, or send copies via e-mail. But for now, click on the Close 
Window button on the toolbar to return to the pathway. 

 

If you wish to add your own step to the Agenda Items, use your mouse to select 
the line in which you want it to appear so that it is highlighted, (in the example 
below under the Consensus Builder tool), and then go to the toolbar and select the 

Manual Step tool:  

When you are ready to hold the meeting, launch it, using the agenda to keep it 
running efficiently. You can edit colors, fonts, and other style characteristics.  

One of the nice features of the Meeting Agenda is that the launch buttons for all 
the items are included on the agenda itself. This eliminates the need to switch 
back and forth between the pathway and the agenda when launching tools.  
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Templates 

PathMaker 5.5 provides built-in templates for the project pathway and tools. You can modify them, or create your own, so that 
you have a template that represents the way your organization solves problems.  

From the File menu, choose New. In the Start Project dialog box that opens, select the "Using a project template" option and 
click on the OK button. From the list of standard templates, choose Process Improvement, and then choose OK. The file opens - 
there are lots of steps, but they are empty, waiting for you to fill them in. You can launch, add, delete, and edit steps. 

Open a form tool. From the File menu, choose Change Template . In the Select A Template  dialog box that opens, choose the 
template you wish to use. Now you have a standard form provided by PathMaker, you can change it the way you prefer. 

When you have designed your own tools and pathways, you may save them as templates for future uses. From the File menu, 
choose Save As Template . Enter a template name at the prompt. The next time when you are choosing templates for pathway or 
tools, the new template you made appear in the list. 

PathMaker 5.5 allows you to save templates in different template databases. When you choose a template, you can select a 
template contained in a template database other than the current using the Browse function. You can also use the Browse function 
to save a template in different template databases.  

Note: Please be aware that any templates created in previous versions will need to be converted.  See the Template 
Maintenance Dialog Box. 

Saving a Project as a Template 

Although PathMaker files are normally saved as projects, they can also be saved as pathway templates. A pathway template is 
intended to get people started on a project. The pathway template suggests what tools to use when, and provides access to helpful 
information.  

If a person or team devises an effective problem-solving approach, it can be saved as a template. Any project-specific data can be 
removed, so that it provides a general approach that others can use. After a file is saved as a template in a Template Database, it 
will appear in the list of available templates when a new project is started using that Template Database. 

To save a file as a template: 

From the File menu, choose Save As Template . The Save As Template  dialog box will appear.  

In the box labeled "Type a name or select a template from the list", type in a descriptive name for your template. This name will 
appear in the list of templates to choose from when you start a new project. An example title could be "Improving a Process" .  

If you want to save the template in a Template Database other than the current one, choose the Browse button to open the Open 
Dialog Box, and you can select the Template Database you want the template to be saved in. Or you can type a new Template 
Database name into the Open Dialog box to create a new Template Database. 

Choose the OK button to save. 

Note: 
All the pathway templates and tools templates are stored in Template Databases. PathMaker allow you to store templates in 
different Template Databases, which helps you classify your templates.  

 

Saving a Tool as a Template 

You do not need to save a tool after editing it, since PathMaker saves all the changes automatically. However, you may wish to 
save a tool as a template for future use, so that you don't have to repeat steps to format it the way you prefer. 
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To save a tool as a template: 

1. From the File menu, choose Save As Template . 

2. In the Save As Template  dialog box, type in a name for your new tool template in the box labeled 'Type a name...' 

3. If you want to save the template in a Template Database other than the current one, choose the Browse button to open     
the Open Dialog Box, and you can select the Template Database you want the template to be saved in. Or you can type 
a new Template Database name into the Open Dialog box to create a new Template Database. 

4. Choose the OK button to save the tool template. 

 

Note: 
All the pathway templates and tools templates are stored in Template Databases. PathMaker allow you to store templates in 
different Template Databases, which helps you classify your templates.  

Instant Messages and Discussions 

PathMaker 5.5 gives you convenient ways to discuss issues online with your team members.  

Use the Send Message button to send messages to the team members:  

 

Use the Display Online Users button to check the users who are working at the same tool with you:  

 

 

Start a discussion at the Discussion History list and invite other team 

members to join you.   

All the discussion messages you and your team members enter in the 
Discussion window are saved with the project. 

 

 

 

Exiting PathMaker 

Quitting PathMaker closes any open projects as well as the application. 

To quit PathMaker: 

From the File menu, choose Exit.  

 

Copyright © 2003 by SkyMark Corporation. .All rights reserved. Reproduction of any part of this work beyond that permitted by 
Section 107 or 108 of the 1976 United States Copyright Act without the permission of the copyright owner is unlawful. Unauthorized 
reproduction or distribution of this penalties, and will be prosecuted to the full extent of the law. PathMaker is a registered trademark of 
SkyMark Corporation.  All other trademarks are the property of their respective owners. 
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 9   Appendix 2 – shipyard report 
 

What follows are screen shots from the Atlantic Marine project to assess 
possible solutions to the over-spray problems the yard has been facing. 

 
These extracts are modified to reveal only non-commercially confident items. 

 
There is a dialogue box with each screen shot extract to describe what has 

been undertaken at each stage.
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The Yards own standard procedure a work document has been hyper-linked 
into the project file so that all relevant documents are contained in this “smart 
file” irrespective of where they actually reside on the computer or the network. 
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This and the following screen shot show the cause and effect  analysis as 

carried out by the yard team on line to identify the possible factors that 
influence good shrink wrap of a vessel. 

 
The system took a couple of attempts to organise correctly but once a layout 

is established it is easy to add more branches and boxes and to navigate. 
There is no real limit to the number of branches and sub-layers. If you want to 
add more you simple click on the “+” sign next to the box and it will expand at 

that level. 
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The cause and effect tool is one of the standard tools within the pathmaker 
software and is easy to use. 
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The meeting tool allows you through one format to contact all people on a 
project and notify them of a meeting. This is also then stored within the smart 

file so that all material relating to the project is readily at hand. 

 
 

Another one of the basic forms from Pathmaker, the software does offer 
scope to customise these either internally or allow you to develop your own 
with a hyper-link. This really does make the tool very flexible to use with all 

elements of Microsoft Office software. 
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The brainstorming facility allows team members to brainstorm on line and add 
to the process as they think of new ideas. 

 
Again it is relatively easy to use and each idea can be subsequently marked 

for further study or reject as appropriate. 
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The team can then be polled to vote on particular courses of action and again 
all feedback is conveniently stored in the one project location. 
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Chart data can be collated, if appropriate, and X-bar charts generated. 

 

 
 

The force field tool allows problems and issues to be raised to identify the 
factors that may prevent a particular solution from being adopted, so that the 

team can assess how best to overcome these problems. 
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The yard had developed its own 5Y programme and had its own forms for this 
process, these were easily linked into Pathmaker through the Hyper-link 

function, keeping consistency with other yard initiatives and therefore not re-
inventing the wheel. 

 
In this sense the software is like a project specific Lotus notes approach but 

with emphasis on problem solving rather than project management. 
 

The following slides are further extracts from alternative projects the yard has 
run using Pathmaker. 

 



 
 

 Page 20 of 23 
FINAL REPORT: 2005-360 
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The forms below are created in Excel and hyper-linked to the Pathmaker 
project smart file. 
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